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PART 1: ON1 RESIZE AI 2023 OVERVIEW

Resize AI 2023 is the latest version of ON1’s professional-quality resizing tool. Rebuilt from the ground 
up with an entirely new resizing engine, Resize AI uses state-of-the-art AI neural networks to create the 
highest-quality photo enlargements of any resizing tool on the market.

Existing methods of photo enlargement make up new pixels or resolution by copying those around them, 
which often leads to enlarged photos with less detail, soft edges, and more noise. Resize AI’s super-
resolution technology enlarges photos while maintaining and recovering detail and sharpness. Resize AI’s 
primary features include:

• Create large prints. Resize AI excels at making stunning poster-sized prints. Easily crop to a 
specific paper size, resize the photo with the ultimate detail, and then print it directly or save 
the file to send to a photo lab.

• Crisp details. Resize AI upscales your photo to any size and sharpens the final details 
incredibly well. You can even crop a portion of your photo and still have amazing quality and 
detail. It can equate to having a longer lens without the expense or weight.

• Breathe new life into old photos. With older digital photos, size and quality do not compare 
to what is available today. ON1 Resize AI lets you remaster old images, making them bigger, 
sharper, and cleaner than ever before.

• Face recovery. ON1 Resize AI uses an advanced machine-learning model that detects small 
faces and enhances them with realistic detail. It can virtually reconstruct a face from modest 
details, adding realistic features and textures. You can turn this feature on or off for each face 
and control the overall strength to blend best with the original photo.
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• AI-based noise reduction. — For original photos with high levels of noise — or photos with 
JPG artifacts — you can Resize’s built-in noise reduction, powered by ON1’s NoNoise AI, to 
reduce noise and artifacts during the resizing process, leading to higher quality enlargements.

• Gallery Wraps. Resize AI’s gallery wrap feature can add reflected or stretched wings to the 
edge of your photo so you can make a canvas gallery wrap without losing image area.

• Tiling. Divide the photo into tiles or strips to make it easier to print a mural. You control the 
size of the tiles and how much they overlap for trimming.

• Batch processing and export. The powerful batch-processing engine in Resize AI lets you 
enlarge a group of photos all at once, while the full-featured export function lets you control 
how they are named, where they are saved, their file type, and much more. You can even add 
custom graphic- or text-based watermarks to your exported photos.

• Print presets for easy automation. When preparing photos for print, knowing the proper 
resolution for your printer and the correct amount of sharpening for your paper can be 
confusing. Resize AI’s built-in printer-specific presets make this a breeze 

• Complete printing support. By incorporating the full print engine from ON1 Photo RAW, 
Resize AI lets you print directly from the app, whether used in standalone mode, or as a 
plug-in. You can even use Resize’s soft proofing feature to see how your photo will look when 
printed using specific printer and paper profiles.

• Powerful workflow integration. Resize AI works either as a standalone application, or as a 
plugin for Capture One or Adobe’s Lightroom Classic, Photoshop, and Photoshop Elements. 
Lightroom Classic and Capture One also support Resize AI’s batch-processing feature, letting 
you process multiple images quickly and easily. And when used as a Photoshop plugin, Resize 
can handle layered files with masks, alpha channels, text, and adjustment layers in RGB, 
CMYK, Grayscale and LAB modes, making it perfect for graphic artists and print agencies.

Getting Help
You can find an extensive collection of 
video tutorials and help documents in the 
Help section of the ON1 website (on1help.
zendesk.com). This is the quickest way 
to dig into Resize. There, you can search 
our Knowledge Base for frequently asked 
questions, and more. 

Inside ON1 Resize, you can use the Learning 
Hub to directly display videos for getting 
started with the app, search the ON1 online 
help system—including with and online 
chat assistant—and the ON1 Shop, where 
you can purchase add-ons and courses for 
Resize.

The Learning Hub is accessible via the Help 
menu or from the Help icon at the bottom 
of the left bumper panel. 

The Learning Hub is available directly within ON1 Resize AI 2023, and includes links 
to videos, ON1’s online help system, and the ON1 store.

https://on1help.zendesk.com
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System Requirements
MINIMUM RECOMMENDED

OPERATING SYSTEM macOS 10.15.6 and above; Windows 10, 
11 (current maintenance releases, 64-bit 
only)

macOS 12 or Windows 11 
(current maintenance releases, 64-bit only)

PROCESSOR Intel or AMD processor with 64-bit support, 2 GHz or faster with SSE 4.2 or later;  
Apple Silicon

RAM 8 GB 16 GB or more

HARD DRIVE 2 GB for installation 2 GB for installation; SSD drive

DISPLAY Windows: DirectX 12, DirectML, Vulkan 
1.1, and OpenGL 4.2 compatible video 
card with 2GB VRAM, 1920x1080 
resolution (at 100% scale factor)
macOS: Metal, Vulkan 1.1, and OpenGL 
4.2 compatible video card with 2GB 
VRAM, 1920x1080 resolution (at 100% 
scale factor)

Windows: DirectX 12, DirectML, Vulkan 
1.1, and OpenGL 4.2 compatible video 
card with 8GB VRAM, 1920x1080 
resolution (at 100% scale factor)
macOS: Metal, Vulkan 1.1, and OpenGL 
4.2 compatible video card with 8GB 
VRAM, 1920x1080 resolution (at 100% 
scale factor)

OPTIONAL APPLICATION 
INTEGRATION

Photoshop CC 2020 and above; Photoshop Elements 2020 and above; Photoshop 
Lightroom Classic CC 2020 and above; Capture One 10 and above

INTERNET A high-speed internet connection and active account for activation, auto-update 
checking, content downloads, and tutorials.

SUPPORTED OPTIONS Supports ICC/ICM profiles for camera input, display, soft-proofing, and printing. 
Hardware display calibration tool is recommended.

LANGUAGES 
SUPPORTED

English, German, Spanish, French, Japanese, Korean, Simplified Chinese, Russian, 
Portuguese, Italian, Dutch

Installation
To install ON1 Resize 2023, you must first 
download and install the ON1 Application 
Manager, which manages your ON1 applications 
and free trials. Once you’ve installed the 
Application Manager, double-click on the app 
icon. You will first be prompted to sign in to your 
ON1 account. The Application Manager will then 
communicate with the ON1 servers, and display 
any apps you already have installed, as well as 
any newer apps that are available for your 
account. To install Resize, choose Available from 
the list on the left side of the window, and click 
on the Install button for the ON1 Resize AI 2023 
item. The Application Manager will install Resize 
in the proper location, and add it to the Installed 
section. From there, you can open the app. The 

The Application Manager is used to install and manage your  ON1 apps and 
plugins. The first time you launch it, you’ll need to sign in with your ON1 
account details.
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first time you launch Resize AI, you’ll need to sign in again to your ON1 account; after that you’re software 
will be authenticated.

Your license lets you install Resize on two 
computers. When you enter your ON1 account 
info, Resize communicates with the ON1 
activation server and registers your software for 
that computer.

If you wish to move your copy of Resize from 
one registered computer to a new one, and you 
are not going to be using the older machine, it is 
best to sign out of the old computer first. Open 
Resize and select Sign Out from the Help menu. 
This will deactivate Resize 2023 on the current 
machine, and you can install and sign in on 
another machine from the Application Manager.

FREE TRIAL VERSION

ON1 Resize 2023 can also operate as a fully 
featured trial version for 15 days from when you 
first launch it. This gives you time to evaluate 
the product and see if it fits your needs. To 
install Resize as a trial, click on the Free Trials 
label in the Application Manager, and click on 
the Install button. The Application Manager will 
display the number for days left in your trial; to 
purchase Resize, click on the Buy button in the 
Free Trials section, or the Buy Now button in the 
top right corner of the Resize window.

MAC INSTALLATION LOCATION
On a Mac, the application is installed in the ON1 Resize 2023 folder in the Applications folder. 

If a previous version of ON1’s Resize, Perfect Photo 10 or Perfect Photo Suite is found, it will be maintained 
or replaced based on your preference during installation.

Support files are installed into /Library/Application Support/ and ~/Library/Application Support/ folders.

WINDOWS INSTALLATION LOCATION
The application is installed in the ON1 Resize 2023 folder in the \Program Files\ON1\ directory. If a 
previous version of ON1’s Resize, Perfect Photo 10 or Perfect Photo Suite is found, it will be maintained or 
replaced based on your preference during installation.

Support files are installed into \ProgramData\ON1\.

When using the ON1 Application Manager, the Available section (shown top) 
will list all licensed apps and plugins associated with your account. You can 
install any of those apps by clicking on the Install button, after which they will 
be listed in the Installed section of the Manager.
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UPGRADING FROM PREVIOUS VERSIONS

If you have earlier versions of ON1 Resize on your computer, the installation process will move over any 
crop presets. 

PRODUCT IMPROVEMENT PROGRAM

We believe that the best products are made by listening to our customers. We use many methods to 
gather your ideas and feedback including: emails, surveys, direct conversations, market analysis and the 
Product Improvement Program. The Product Improvement Program is built into our software and gathers 
information about how our software is used. It is the most accurate way for us learn what features are 
important to you and how our products fit into your workflow.

Enrollment in the program is voluntary. When you participate, we collect basic information about how you 
use our programs and basic information about your computer. This information helps us learn what features 
are important to you and how we can make our software easier to use. No personal information is collected 
and you will not be contacted.

You can choose to participate in the Product Improvement Program the first time you launch ON1 Resize AI 
2023. You can change your participation later, just click the Help menu, then Help Improve ON1 Products.

To learn more about the Product Improvement Program, go to the Support area of the ON1.com website.

Uninstalling ON1 Resize AI 2023
To uninstall ON1 Resize AI 2023, first deactivate your product: open ON1 Resize AI 2023 and select Sign 
Out… from the Help menu. (This will allow you to transfer your license to another computer.)

MACOS

1. Go to the Applications/ON1 Resize AI 2023/Documentation folder.

2. Double-click on the Remove ON1 Resize AI 2023 application.

WINDOWS

1. Go to Control Panels.

2. Under Programs select Uninstall a program.

3. In the list that comes up select ON1 Resize AI 2023 and then click on the Uninstall button.

Working with Files
ON1 Resize AI 2023 can view and open the following file types, in RGB color, at either 8/16 bits per pixel:

• Raw files from most major camera manufacturers (file extension varies by manufacturer)

• Digital Negative (DNG)
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• Photoshop (PSD)

• Photoshop Large Document (PSB)

• Tagged Image File Format (TIFF)

• Joint Photographic Experts Group (JPEG)

• Portable Network Graphic (PNG)

• High Efficiency Image Format (HEIC) 

When you wish to export or share images, Resize can save files in PSD, PSB, TIFF, JPEG, PNG and DNG 
formats. (See page 35 for information on Resize AI’s Export feature.)

Launching Resize AI as a Standalone App

MACOS

Open the Finder, and navigate to the Applications folder. Find the ON1 Resize AI 2023 folder and double-
click on the Resize AI 2023 icon. You can also add ON1 Resize AI 2023 to your dock (or Launchpad) for easy 
access by clicking and holding the icon in the dock and selecting the Keep In Dock option. 

WINDOWS 10

Open the Start screen by pressing the Window key, and select ON1 Resize AI 2023. If you selected the 
“Add Icon to Desktop” option during installation you can also access Resize from there.

OPENING PHOTOS FROM WITHIN RESIZE AI

When you first launch Resize AI, the main window will have an icon in the center and an Open Photos 
button. To start working on a single photo, you can either click the button and choose the photo from your 
computer’s file-selection window or drag a photo from your desktop into the Resize window. To work with 
multiple photos, you can drag a 
folder or selection of files into 
the window, or click the Open 
Photos button and select a 
folder or multiple items within 
a folder using your system’s 
file-selection tools. (See page 
29 for detailed information 
on working with Resize AI once 
you have opened a photo or 
group of photos.)

You can also drag a photo 
on top of the Resize AI 2023 
icon, which will launch the app 
with that image, bypassing the 
startup window.
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Using Resize AI as a Plugin
In addition to using ON1 Resize as a standalone app, you can easily export single photos to Resize 
from Adobe Photoshop, Photoshop Elements, Lightroom Classic and Capture One. When working with 
Lightroom Classic or Capture One, you can also batch-process multiple images inside Resize AI.

USING RESIZE WITH ADOBE PHOTOSHOP

ON1 Resize AI 2023 is accessible from within 
Photoshop via the File > Automate menu. 
Selecting that item will open the image in 
Resize. When you are finished resizing your 
image, clicking the Done button inside Resize 
will apply the transformation and save it back 
to Photoshop at the new dimensions. (Clicking 
Cancel inside Resize will close the file without 
making changes.)

Resize supports layered Photoshop files with masks, text, and adjustment layers in RGB, CMYK, Grayscale 
and LAB modes. All layers — including hidden ones — are preserved in the resizing process. 

USING RESIZE WITH PHOTOSHOP ELEMENTS

ON1 Resize AI 2023 is accessible from within 
the Photoshop Elements Editor via the File > 
Automation Tools menu. Selecting that item will 
open the image in Resize. When you are finished 
resizing your image, clicking the Done button 
inside Resize will apply the transformation and save it back to Photoshop at the new dimensions. (Clicking 
Cancel inside Resize will close the file without making changes.)

NOTE: The Automation Tools submenu — used to send a photo from Elements 
to Resize — is only available when working in the Expert tab of the Elements 
Editor app. In addition, layered files are not supported from within Elements; 
you must flatten the layers in a photo before it can be sent to Resize AI.

USING RESIZE WITH LIGHTROOM CLASSIC

ON1 Resize AI 2023 can be accessed from within Lightroom Classic CC, providing an integrated, round-trip 
workflow of your images. There are two primary ways to use Resize with Lightroom, via the Plug-in Extras 
command in the File menu and the Edit In command in the Photo menu. Both generally work the same way, 
the primary difference being where you choose the file format of the photo being opened in Resize, and 
that you can batch-process multiple photos via Plug-in Extras. Using Plug-in Extras opens the file using the 
format chosen in Resize’s Plugins Preferences pane, while Edit In uses Lightroom’s export facility to send a 
single image to Resize. 
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If you use Resize as a plugin from Lightroom, we recommend using the Photoshop format (.PSD) as the 
exchange file format for maximum compatibility. If your saved file will be larger than 2GB, or more than 
30,000 pixels on a side, your image will automatically be saved in the .PSB (or Large Document) format. 
This is a version of the PSD format designed for larger file sizes, and is fully compatible with Resize.

Using ‘Plug-in Extras’

To edit an image in Resize, select the image in Lightroom, go the File menu and select the Plug-in Extras 
submenu, and choose ON1 Resize AI 2023. 

When you access ON1 Resize AI 2023 through 
the Plug-in Extras menu there are file-handling 
options that are controlled in the Plugins tab of 
the Resize Preferences window (shown on the 
right). These should be configured in advance, 
based on your desired workflow. Once these 
are set, all images sent to Resize AI 2023 via 
the Plug-in Extras submenu will use these 
characteristics:

• File Format: Determines what type of 
file will be created. The default is PSD. 
You can also select JPG or TIFF.

• Color Space: Determines what RGB 
working color space is used; Adobe 
RGB 1998, sRGB or ProPhoto RGB.

• Bit Depth: The bit-depth drop-down menu determines the bit depth (8 or 16 bits per pixel).

• Resolution: Determines the resolution of the file.

• Stack with Original: When enabled, the new image 
is stacked with the original image upon return to 
Lightroom from Resize.

• Use Original for Single PSDs: When enabled, if you 
select a single image in PSD format, the original file 
will be edited, rather making a copy.

• Ask Every Time: When checked, Lightroom will 
present these export copy options whenever you 
chose an item from the Plug-In Extras submenu. 
Turning this option off will bypass the file-export 
window inside Lightroom, using the options set in 
Plug-In Preferences window. 

You can access Resize from Lightroom Classic from either of two submenus, File > Plug-in Extras (above, left), or Photo > Edit In (above, right). There 
are small differences between the options, but both will get you to Resize quickly. Which one you choose is open largely to personal preference.

When sending a file from Lightroom to Resize via Lightroom‘s Plug-In Extras 
menu, the edited file will be created according to your settings in the 
Lightroom Plug-Ins section of Resize’s Preferences window (highlighted above 
in red).
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If you have the Ask Every Time option checked, you’ll be presented with the Export Options window 
inside Lightroom whenever you send an image to Resize (shown on the previous page). The Export Options 
window lets you adjust the file format characteristics as needed, and is designed for users with variable 
workflow needs. If you find that you use the same options every time, then you can set those parameters in 
Resize’ Preferences window by unchecking the Ask Every Time option.

Batch processing multiple files with Plug-In Extras

You can batch process multiple images for resizing via Plug-In Extras. Select the images you wish to work 
with in Lightroom’s Library module and choose Resize from the Plug-In Extras submenu. The Export 
Options window will open with two batch options:

• Pause on First Photo: Use this option when you wish 
to apply the exact same editing operations to a group of 
photos. This option will open the first selected image 
inside Resize. There, perform any editing option you 
wish, including applying presets, any cropping, and 
other adjustments in Resize. When you have finished 
with your edits, click Done. Resize will then apply all 
of the edits — including the exact crop position — to 
each image in the group, and return you to Lightroom.

• Pause on All Photos: This option lets you sequentially 
edit the images in the batch. Resize will open each 
image in the destination tab, where you can edit it as desired. When you are finished editing 
with one photo, click Done, and Resize will save that photo and open the next one, with 
the previous photo’s Resize settings applied. (You can reset any or all of those settings as 
desired.) When you have finished editing the last photo in the group, clicking Done will save 
the image, close Resize and return you to Lightroom.

Using ‘Edit In’

When you use the Photo > Edit In submenu, Lightroom will ask 
you each time for the resultant format how you wish to edit the 
selected image. You have three choices: 

• Edit a Copy with Lightroom Adjustments, which 
makes a copy of the file that includes any edits you 
have made in the photo;

• Edit a Copy, which copies the original photo without 
any changes made in Lightroom; or

• Edit Original, which sends the original version of the 
photo to Resize, unless the photo is a raw file, in which 
case the option will be unavailable.

In the Copy File Options, you set  the file type (TIFF, Photoshop 
PSD or JPEG), the color space and bit depth for the resultant file.

When you have set your options and click the Edit button, 
Lightroom will create a new file (or send the original) and launch 
Resize. When you’re finished, click the Done button to save your changes, close Resize, and return the file 

The Batch Options window comes up when you wish to 
send a group of photos from Lightroom to Resize. (If you 
have the Ask Every Time option set in Resize’s 
Preferences, Batch Options will be displayed as a 
section in the Export Options window..)
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to Lightroom. To return to Lightroom without saving your edits, click Cancel. Note that, because ‘Edit In’ 
causes Lightroom to create a file before it gets sent to Resize AI, that new file will remain in your Lightroom 
library. (If you cancel in Resize when using Plug-in Extras, Resize will not send the canceled file back to 
Lightroom.)

USING RESIZE WITH CAPTURE ONE

When you edit an image sent from Capture One to ON1 
Resize, Capture One creates a variant of the current photo. To 
resize an image inside Capture One, follow these steps:

1. Open the image in Capture One.

2. From the Image menu, select Image > Edit With > 
ON1 Resize AI 2023.

3. Choose the file characteristics you wish to use 
in Resize—File Type, Bit Depth, ICC Profile, and 
Resolution—and click the Edit Variants button to 
launch Resize.

When you’re finished editing your photo, click the Done button 
in Resize. Your variant will be visible in the current collection.

Batch processing Files in Resize with Capture One

You can process multiple images for editing in Resize with Capture One. Select the images you wish to work 
with in Capture One and choose Image > Edit With > ON1 Resize AI 2023. The Export Variant window will 
open with an additional tab, ON1 Batch, which contains a pop-up with two options:

• Pause on First Photo: Use this option when you 
wish to apply the exact same editing operations to 
a group of photos. This option will open the first 
selected image inside Resize. There, perform any 
editing option you wish, including adding filters, 
applying presets, retouching operations, cropping, 
masks, local adjustments and more. When you have 
finished with your edits, click Done. Resize will then 
apply all of those edits to each image in the group, 
and return you to Capture One.

• Pause on All Photos: This option lets you 
sequentially edit the images in the batch. Resize will 
open each image in the destination tab, where you 
can edit it as desired. When you are finished editing with one photo, click Done, and Resize 
will save that photo and open the next one, with the previous photo’s Resize settings applied. 
(You can reset any or all of those settings as desired.) When you have finished editing the last 
photo in the group, clicking Done will save the image, close Resize and return you to Capture 
One.

Before sending multiple images to Resize from Capture One, you can also click on the Basic, Adjustments 
and Metadata tabs to change those options. Once you have all the options chosen, click the Edit Variants 
button and Resize will process that group based on your batch settings.
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Extras
ON1 Resize AI 2023 supports two additional file 
types that can be used within the app. These files 
are called Extras, and the file types include:

• Resize Presets, specific crops for a wide 
range of paper and printer types for use 
within the Resize module (see page 28).

• Watermarks, image files (transparent 
PNGs) that can be used with the 
Watermark pane of Resize’s Export (page 
39) and Print (page 48) features. 

You can import, export and manage presets and 
watermark files via the Extras Manager, which is 
available when you have a photo open in Resize.

To import extras, choose Manage Extras from the File menu, then click on the Import button in the footer 
of the left column. A dialog box will appear where you can select the files to import. If you want to import 
an entire folder, open the folder, select the first file, then shift-click on the last file. Click Import when your 
selection is complete. Then, select a category for your extras to live, which is where you will be able to find 
it inside Resize. You can select from an existing category or create a new one.

ORGANIZING PRESETS

When you are in the Extras Manager, you’ll see ‘+’ and ‘-’ buttons, which let you add or delete categories to 
the list of your presets. You can also add subfolders to any of the categories, which can help organize and 
manage large collections of presets. You can use drag-and-drop to move existing categories into another, 
or you can add a category subfolder to an existing category by clicking on the category and then clicking 
on the ‘+’ button in the Extras Manager window. (When you are importing presets, Resize gives you the 
opportunity to add presets to any category folder or subfolder.)

In addition to the Import option, the Presets section of the Extras Manager will also let you export presets, 
for sharing with other users, or to save seldom used presets for archiving purposes. To export a complete 
category, click on the category in the list on the left side of the window and click on the Export button. 
This will export a folder that contains a single .ONpreset file, which includes all of the presets from that 
category. If you would like to export a single preset, click on the preset from the list on the right side of the 
window and click Export.

HOW TO DELETE EXTRAS

You can remove imported extras using the Extras Manager. Follow these steps:

1. Open the Extras Manager in any module (File > Manage Extras).

2. Click on the extras type that contains the content you wish to remove. This will display 
categories within that type.
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3. To delete an entire category, select in the left column and click on the Delete button in the 
footer of the left column.

4. To delete individual extras, select them in the right column and click on the Delete (‘—’ in the 
Presets tab) button in the footer of the right column.

Deleting extras is permanent and cannot be undone.

Customizing Resize’s Keyboard Shortcuts
You can customize ON1 Resize AI 2023’s hotkeys 
via the Keyboard Shortcuts window. This window 
lets you view and change the shortcuts for any tool, 
tool option, module, or menu item inside Resize. You 
can assign shortcuts to items that don’t yet have a 
shortcut, build multiple sets of shortcuts as preset 
styles, and create a summary of your shortcuts that 
can be viewed in any web browser.

To view or change Resize’s hotkeys, choose Keyboard 
Shortcuts from the Edit menu. By default, Resize’s 
shortcuts will be displayed, organized hierarchically 
by the following groups: 

• Modules, which is inherited from ON1 
Photo RAW, and is not used in Resize AI.

• Tools, for the Crop and Zoom tools. 

• Menu, which includes all of Resize’s menu 
items. 

You open each group by clicking on the triangle to 
the left of the group name, or you can use the search 
field at the top of the Keyboard Shortcuts window to 
search for a command in any of the groups. 

Each command that has an assigned key will display that key in the Shortcut column. The Shortcut field 
will be empty for any command that doesn’t have an assigned key, and any field with a grayed-out shortcut 
means that you cannot modify that command’s keys.

NOTE: Some keyboard shortcuts cannot be changed. These include menu 
commands used by the operating system (Cut, Copy, Paste). Also, you can’t use 
the Escape, Return/Enter, or Delete keys as a shortcut.
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MODIFYING HOTKEYS

The Default preset style’s hotkeys cannot be modified, but you can create your own set of shortcuts by 
double-clicking on any command you wish to add or change. You’ll be asked if you want to create a new 
preset. Clicking Yes will let you name the new preset style, and Resize will make a duplicate of the Default 
set.

At this point, you can change any existing hotkeys —or add your own shortcuts for commands that don’t 
have them —by double-clicking in the Shortcut field for that command. The field will be highlighted, and you 
can press the key or key combination you wish 
to use. If that key is used by another command, a 
dialog will come up, informing you of that, and 
giving you the option of either keeping the 
existing hotkey/command combination, or 
changing it to the new command.

When you change a default shortcut to a new 
key combination—even for commands and 
options that didn’t initially have a shortcut—a 
Reset arrow will appear to the right of the 
Shortcut field. Clicking the icon will reset the 
command to its original state, from the Default 
preset style.

To delete a shortcut, double-click in the Shortcut 
field and press the Delete key. 

The Summarize button at the top of the 
Keyboard Shortcuts window will create an 
HTML table of the current set of hotkeys. You’ll be asked where to save the file, and double-clicking on it 
will open that table in your default web browser, where you can view or print the list. 

You can return to the original Resize shortcuts by clicking on the pop-up menu at the top of the Keyboard 
Shortcuts window, and choosing Default from the list of preset styles. That menu can also be used to 
create a new preset or to delete an existing one that you created. The Default preset cannot be removed, 
however.

When you add or change a hotkey the first time, Resize will prompt you to 
create a new preset style, which makes a duplicate of the Default preset. You 
can switch between preset styles—including back to Resize’s Default set—by 
using the pop-up menu at the top of the Keyboard Shortcuts window.

If you try to add a shortcut key combination that is already in use, Resize will 
let you know, and give you the option of keeping (Cancel) or removing (OK) the 
other command/shortcut.
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Changing Resize’s font size
By default, Resize AI prioritizes the main workspace to focus on photos, using a small font size to display 
panel names, labels, file names any other basic text. You can adjust the default font size to one of three 
settings, Small, Medium or Large, by choosing the General tab of Resize’s Preferences window. Select the 
option from the Font Size pop-up, and restart Resize to have the effect take place.

Resize AI has three options for displaying type in the main workspace, Small (left), Medium (middle), and Large (right). To change the size, go to the General tab of 
the Preferences window, and pick the new option from the Font Size window. The change will take effect the next time you launch the app.
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PART 2: USING ON1 RESIZE AI 2023

ON1 Resize AI provides you with an easy-to-use work area for editing your photos. Below is an overview of 
the main sections, including:

A. Tool Well: Includes the Crop and Zoom tools.

B. Settings/Help: Buttons for accessing Resize AI’s preferences and help windows. The button 
at the bottom shows/hides the Presets pane.

C. Presets: A library of presets for different printers, paper types and print sizes.

D. Search Box: Search for presets by name.

E. Preview Window: Preview of image to be resized.

F. Zoom Level/Split Screen/Soft Proofing: Controls for setting the zoom level; displaying a 
split-screen (before/after) view; and for turning soft proofing on or off.

G. Tool Options bar: Lists options for the current tool. 

H. Navigator/Levels/Info Pane: Navigator, levels (histogram) and general photo information.

I. Photo Size: Displays the pixel dimensions of your photo, and lets you adjust the dimensions 
for the resized image.

J. Settings: For selecting the resizing method and adjusting smoothness in the final image.

K. Noise Reduction: Applies noise reduction — using ON1’s NoNoise AI technology — during the 
resizing process.

L. Sharpening: Sets sharpening options for the resized photo.

M. Face Recovery: Enhances the details in small faces in a photo.
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N. Film grain: Adds realistic film grain to the final image. 

O. Tiling: Lets you tile the finished image into a series of individual files for assembling into a 
mural or other oversized print piece. 

P. Gallery wrap: Sets a custom border on the finished image for use when printing on canvas.

Q. Reset All/Cancel/Done: Reset all settings; cancel and return to the startup window or 
external application without saving; save and close open images with the current settings.

R. Print/Export/Share: Prints the current image (or selection, when multiple images are 
selected); opens the Export window; lets you share your image (MacOS only).

Basic ON1 Resize AI Workflow
The power of Resize AI is in the concept of resolution on demand;  Resize should be used as one of the last 
steps in your workflow before printing. You can work with a modest size file, which makes your editing 
faster and takes less hard drive space and memory. Then when you are ready to output your file, enlarge 
it with Resize AI to the desired size and sharpen it for output. This means you don’t have to keep multiple 
versions of a file at different print sizes; you just create what you need on the fly. ON1 Resize also supports 
layered Photoshop files so you can maintain all your layers in the entire process.

When working inside Resize AI — whether in standalone mode, or when using it as a plug-in — you have 
multiple options for resizing:

• You can use the Crop tool to crop to a specific paper size;

• You can adjust the output size (with or without cropping) by using the Photo Size pane at the 
top of the Resize panel; or

• You can use Resize AI’s built-in presets to crop and resize images to a specific printer, paper 
type and print size. Presets can include everything from specific crop and paper sizes, output 
sharpening parameters, film grain settings and more.

All of these methods can be edited and changed as you work. Once you’ve set your output dimensions, use 
the Sharpening, Film Grain, Tiling or Gallery Wrap panes as needed. The Preview window updates as you 
adjust your settings, and you can go back and forth between the original and edited versions of your image 
as you work, either in a direct before/after view, or in an adjustable split-screen view.

When you’ve finished making your adjustments, pressing the Done key will prompt you to save your image 
— when using Resize as a standalone app — and return you to the opening screen; when used as a plug-in, 
Resize will save your image and return you to the originating app.

When batch-processing multiple photos in Resize AI, the workflow is slightly different, depending on 
whether you are using Resize in standalone mode or as a plug-in. For details on batch processing in 
standalone mode, see page 29. For batch processing with Lightroom Classic, see page 9; with 
Capture One, see page 10.

Navigating the Preview Area
The Preview area is the main section where you preview and work on images. You can use the View tool for 
navigating this window.
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This tool, which is the default tool selected when you open an image in the Resize module, adjusts the 
magnification of the image in the Preview window. With the Zoom tool selected, click in the Preview 
window to zoom in and center the image at the location clicked. 

Hold down the Option/Alt key to pan around the magnified image. You can also double-click the View tool 
in the Tool well to set the image to 1:1 (or 100%) magnification view, which shows every pixel. This is best 
when examining small details, and when previewing the effects of Resize AI’s sharpening and resampling on 
your photo. 

As you adjust settings in the Resize panel on the right side of the screen, the preview will be updated in real 
time. If you’re performing a significantly large resize operation, it can take a few seconds for the preview to 
be updated completely. 

You can use the Split Screen control at the bottom of the main window (shown below) to split the screen 
into two panes: the one on the left will display the original (before) image; the one on the right will display 
the image with Resize AI settings applied. You can use the square in the center of the screen to make one 
of the panes larger, and can use the Zoom and Hand tools to view more detail or scroll around the image. 
(Click the Split Screen button at the bottom of the window to turn it off.)

NAVIGATOR, LEVELS AND INFO

At the top of the control panel on the right of the main window are the Navigator, Levels, and Info panes. 
These four panes can be useful for inspecting and viewing details in your image.

The Navigator Pane

This gives you a birds-eye view of your image. The white 
square region marks the image area that is visible in the 
preview pane. You can pan view by clicking and dragging 
inside the white region.

The bottom of the Navigator pane has four buttons: 

• FIT: Zooms to fit the current canvas size.

• 100: Zooms to 100%, or actual pixels.
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• 50: Zooms to 50%

• 25: Zooms to 25%

The Levels Pane

This gives you a color chart of the shadow, mid-tone and 
highlight areas based on the image RGB values (often 
called a histogram). This is useful to show areas within 
the image that may be clipping, which can signify loss of 
highlight or shadow detail.

The left side of the histogram represents the shadows, 
while the right represents the highlights. At the top 
of each end is a triangle. If the triangle is lit, there is 
clipping on that side of the histogram. Clicking on the arrows will activate the clipping overlay. Areas of a 
blue overlay will display as pure black; areas with the red overlay represent pure white. You can turn the 
clipping view off again by clicking on one of the triangles. You can also temporarily enable clipping view by 
holding down the J key at any time. 

The bottom of the Levels pane displays the RGB values of the pixel underneath the current cursor location.

The Info Pane

The info pane displays important photo metadata, 
including:

• Camera type

• File type

• Focal length and lens information

• Date and time captured

• Exposure information

• ISO

• Shutter Speed

• Aperture

• Exposure Value

• Filename

• Dimensions

• File Size
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CROP TOOL

The Crop tool is used to crop and resize the entire image. Resize AI’s Crop tool removes any pixels outside a 
crop box and changes the canvas size at the same time.

To crop the image, select the Crop tool. Then adjust the corner handles of the crop tool overlay. The area 
outside the crop box appears darkened for guidance. You can resize and move the image inside the crop 
box. When you are satisfied, press the Apply button in the Tool Options bar or press Enter.

Working with the Crop Tool

• Moving the Image: To move the image inside the crop box, click and drag inside the box. You 
can also nudge the image using the arrow keys on your keyboard.

• Resizing a Crop Box: To resize the Crop Box, click and drag on any of the resize handles. 
Clicking on a corner handle allows you to adjust two sides at the same time. Clicking on a side 
handle allows you to adjust that side. If you hold the shift key down while adjusting the size, 
the proportions of the box are maintained. To rotate the crop box, move outside a corner 
until the tool changes to rotate. You can also set the aspect ratio or size of the crop box in the 
Tool Options bar.

Crop overlays

When you select the Crop tool, Resize has the option to display guidelines as an overlay on top of your 
photo. These overlays can be used as compositional aids for cropping. Resize includes a number of overlays 
that you can display during a crop session, and they can be accessed from the overlay pop-up menu in the 

The Crop Overlay in Resize.
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Tool Options bar when the Crop tool is active. There are seven options — Rule of Thirds, Grid, Diagonal, 
Triangles, Golden Ratio, Golden Spiral, and None — and you can easily go back and forth between them as 
desired while cropping. 

In addition to overlay type, there are two other sets of options in the 
pop-up menu: 

• You can choose to have the overlay displayed all the time 
during a crop session, or to have Resize only display the 
overlay when your cursor is in the preview area of the 
workspace.

• When working with the Triangles or the Golden Spiral 
overlays, the Flip Overlay options will be visible, letting you 
flip the orientation of the overlays horizontally (Golden Spiral 
only) or vertically (Golden Spiral and Triangles).

Crop Tool Options Bar

• Overlay pop-up: Selects a crop overlay, sets overlay visibility, and flips the overlay.

• Preset pop-up: Pop-up controls the crop tool mode as well as aspect ratio and document size 
presets.

• Width: Sets the width of the crop box.

• Swap Dimensions: Swaps the width and height. Handy for rotating the crop box.

• Height: Sets the height of the crop box.

• Units: Determines the unit of measure: Pixels, inches, centimeters, etc.

• Leveling tool: Click and drag this tool across an element in your image that should be level.

• Angle: See and adjust the angle of rotation.

• Rotate: Rotates the image 90 degrees.

• Cancel: Resets the crop tool.

• Apply: Applies the crop and resizes your photo.

Crop Tool Modes

The Crop tool works in three modes, which are all accessible via the Preset 
pop-up in the Tool Options bar:

• Freeform: In this mode you can adjust the crop box any way you like. 
The image will not be resized. Any area outside the crop box will be 
trimmed off. Use this mode if you just want to change the shape or 
recompose your image for general use.

• Aspect Ratio: Locks the crop box to an aspect ratio. This ensures 
that the crop ratio doesn’t change, just the size. Use this to trim 
existing pixels while maintaining a ratio without resizing the image.

The Crop Overlay pop-up 
includes seven options for 
setting and displaying overlays.

The Crop tool preset pop-up 
includes options for nearly every 
aspect ratio or print size.
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• Document Size Presets: These let you crop and resize your image at the same time. If you 
know your intent is to print the image at a certain size you can crop and resize the image at 
the same time. Many common sizes are included plus you can create your own.

Leveling the Image

The Crop tool has a special Leveling tool for automatically rotating your image to be level. To access it, first 
select the Crop tool, then perform the following:

• Select the Leveling tool from the Crop tool options bar. Your cursor will change to the 
Leveling tool.

• Click and drag a line across your image that should be level, either horizontally or vertically. 
When you release the mouse the image will be rotated automatically to the correct angle.

Creating custom sizes

You can create document sizes by choosing the Custom 
option at the bottom of the preset pop-up. Resize 
comes with many commonly used print, paper and video 
document size presets but you can also create your own:

• From the Preset pull-down, select Custom > 
Manage Custom Sizes. This opens the Custom 
Document Size Presets window.

• Click on the Add button.

• Double-click on the highlighted untitled name 
and name your preset.

• Double-click on the width and height and fill in the proper values.

• Click on the units and select the proper unit.

• Click on the OK button.

PHOTO SIZE PANE

The Photo Size pane has two sections. The top portion 
displays the file size and pixel dimensions of the photo as 
you edit it. The bottom section provides multiple options 
for resizing your photo.

When you first open an image, the information in the top 
section of the Photo Size pane will be that of the original 
file; as you adjust the resizing options — via a preset, 
the Crop tool or the ‘Resize to’ portion of the Photo Size 
pane — that information will change, reflecting the size 
and dimensions of the resized image. (The original pixel 
dimensions and file size for the current image can be 
viewed in the Info pane.)

The ‘Resize to’ section of the Photo Size pane has seven 
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options for resizing your images: Dimensions, Long Edge, Short Edge, Width, Height, Megapixels and 
Percentage. Most of these options will scale your image proportionally; the Dimensions option is the only 
one that will open the Crop tool, because you are choosing a specific output/paper size for the resized file. 

Here are the specifics for the different scaling options in the ‘Resize to’ pop-up:

• Dimensions. Similar to the document size preset pop-up in the Crop 
tool’s Options Bar (see page 20), this lets you size your image to 
common paper and photographic print sizes, and any custom sizes 
created via the Custom Document Size Presets window. When you 
chose an option from the Common Sizes pop-up, Resize will open the 
Crop tool, so you can crop your image to the appropriate paper size.

• Long Edge and Short Edge. These options are useful when you want 
to lock one edge to a specific length or width and don’t care about 
the sizing of the other edge. Simply choose which option is the 
important one for your photos, and enter the desired amount in pixels, inches, centimeters or 
millimeters. These options can be helpful when batch-processing a group of photos that have 
different orientations, and you want them all to have the same dimension on the long or short 
edge.

• Width and Height. Using this option will scale the current image based on your choice of 
either the width or the height metric. 

• Megapixels. Scales the current image to a specific megapixel count.

• Percentage. This option enlarges or reduces the size of the exported images based on specific 
percentages. Numbers below 100 reduce the image, those above 100 will enlarge the image.

All of the options in the ‘Resize to’ menu include a Resolution section, represented either as pixels/inch 
or pixels/cm. To the right of the field is a pop-up menu with common settings 
for various printers and other output formats. (See “How Much Resolution Do I 
Need?” on page 32 for more information on choosing the proper resolution 
and sizing for your photos.)

You can readjust any of the options in the resizing section at the bottom of the 
Photo Size pane. You can move between options, use the Crop tool, or even 
choose a preset, and Resize AI will recalculate based on your new choices.

SETTINGS PANE

The Settings pane contains the controls for selecting the resizing 
method (or algorithm) and its settings. There are four options in the 
Method pop-up:

• Resize AI 2023 (Standard). This is the default (and 
preferred) option when resizing images. It provides the ideal combination of noise reduction 
and micro-contrast, giving you the best results for most photos.

• Resize AI 2023 (Faithful). This option provides slightly less noise reduction and micro-
contrast than Standard, although the differences will be subtle.

• Genuine Fractals. This is the classic, patented, fractal-based algorithm used in Perfect Resize. 
It is included solely for backward compatibility with previous versions of ON1 Resize. 

The ‘Resize to’ pop-up menu.

The Resolution pop-up has 
common print resolutions.
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• Bicubic. This option is for downsizing images. It has no settings.

The two Resize AI scaling methods have a Smoothness slider, which is designed to reduce artifacts that 
might appear in overly sharp areas of a resampled image. By default, this slider is set to 0. 

Genuine Fractals settings

As noted, the Genuine Fractals resizing method is included solely for backward compatibility with previous 
versions of ON1 Resize. If you wish to use it, there are three sliders for adjusting the resizing parameters:

• Texture. This controls the amount of detail in flat, non-edge areas of an image. Smaller 
numbers (1-2) are good for images with large areas of continuous tone, while larger numbers 
(3-5) are good for images with lots of small detail. Settings beyond 5 will often introduce a 
bumpy noise pattern; it works best when your original image was from scanned film.

• Threshold: This controls the amount of enhanced hard edge detail. The default setting is 25. 
Decreasing the threshold will focus the algorithm on edge information. Settings higher than 
25 will increase the amount of small detail in flatter areas of the image. Settings as high as 
100 are useful for highly detailed images (hair or feathers). 

• Smoothness: The smoothness slider is used to reduce artifacts along hard curved edges. Use 
the lowest setting needed.

NOISE REDUCTION PANE

The Noise Reduction pane incorporates some of the AI-based 
technology behind ON1’s NoNoise AI product (without the 
TackSharp sharpening component). You can use it to reduce 
an original photo’s noise or JPG artifacts as part of the resizing 
workflow, which in turn can lead to higher quality enlargements.

The Amount slider adjusts the overall strength of the noise reduction applied. When adjusting the effect, 
you should view the photo at 100% view.

NOTE: You should not use the Noise Reduction pane on photos that have had 
noise reduction applied previously to them.

SHARPENING PANE

The Sharpening pane contains the controls to add additional sharpness to your final image. You should use 
this pane only after you have resized your image to its intended output size. 

The Styles area at the top of the pane selects preset sharpening options for fixing focus, screen output, or 
print, and includes a pop-up menu with an array of sharpening options for different output needs.

Resize AI features three sharpening methods:

• High Pass: High Pass sharpening is helpful when the original image lacks sharpness.

• Unsharp Mask: Similar to Photoshop’s Unsharp Mask. Resize’s sharpening is different in that 
it is only applied to the luminance of the image, to prevent color artifacts.
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• Progressive: Similar to Unsharp Mask, it sharpens 
different amounts depending on the size of the details. 
Small details are enhanced more than large ones.

Using the Sharpening controls can save you the workflow step 
of adding additional Sharpening before printing and can help 
compensate for loss of sharpness due to dot gain from your printer. 
Sharpening should only be applied at the end of your workflow 
just before printing. If you plan to do additional retouching or 
compositing work after resizing your image, you should disable the 
Sharpening controls.

To sharpen your image for output, use these steps after you have 
your final image ready for output:

1. Zoom in on your image to 1:1. You can do this easily by clicking 100 in the Navigator pane.

2. Enable the Sharpening controls by toggling the on/off control in the pane’s title bar.

3. Select the sharpening method that will provide the best results for your image. You may 
need to experiment to determine this.

4. Adjust the amount slider to determine the amount of sharpening desired.

5. Use the Highlight and Shadow sliders to limit the sharpening from being applied to the 
darkest and lightest areas of the image which can prevent sharpening of noise.

6. Similarly, adjusting the Skin slider can help protect skin tones from being oversharpened in 
the resizing process.

FACE RECOVERY PANE

ON1 Resize’s Face Recovery feature is designed for those times 
when you have a 
photo with a group 
of people, and some 
of the smaller faces 

in the photo have less detail in them. Previously, if you 
used any resampling technology to upscale such a photo, 
those less-defined faces could appear even softer than 
the original photo. With ON1’s face recovery technology, 
you can resize these types of photos and have those faces 
appear with more realistic features and textures.

To use Face Recovery, click the button to the left of the 
pane’s label to turn the pane on, and then click the Select 
Faces button at the bottom of the pane. Resize will analyze 
the photo and display a box around each found face in the 
photo. If the face is standard-sized, the box will be white, 
and that face will not have the face recovery applied to it. 
All smaller-sized faces in the photo will have a green box 
around them, and those faces will have recovery applied, at 
the level determined by the Strength slider. 

When you click the Select Faces button, Resize will analyze the 
photo and put a box around every face it finds. Boxes in green 
indicate smaller faces that will be processed with the recovery 
technology; Boxes in white will not.
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Here are a few tips for working with Face Recovery:

• You can turn each face on (green) or off (white) by clicking inside that face’s box.

• When judging the recovery results, you should look at each face at 100% view. Adjust the 
Strength slider as desired.

• The Strength setting is applied globally to all of the selected faces; you cannot apply different 
settings to each face.

• Sometimes, you might find that Face Recovery helps with larger faces in a photo (for example, 
when dealing with faces that are slightly out of focus). Toggle that face’s box on and off at 
100% to see if it improves the results.

• When you’re done with the recovery pane, click the Done button to dismiss the boxes. 
If you’d like to work with the pane again, click the Select Faces button again. Resize will 
remember all of the faces selected, as well as their on/off state.

FILM GRAIN PANE

The Film Grain setting controls the amount of simulated film grain 
to your image. Adding a modest amount of grain can make your 
image appear sharper visually and can help hide imperfections such 
as JPG artifacts. ON1 has scanned a number of popular film types 
for their grain patterns, and has made them available in the Film 
pop-up.

Adding film grain can be especially useful for monochrome images, 
and should be added just before printing. To add Film Grain to your 
image follow these steps:

1. Zoom in on your image to 1:1. You can do this easily by using the 1:1 Zoom preset located in 
the Navigator pane.

2. Enable the Film Grain controls by toggling the on/off control in the Film Grain pane title bar.

3. Choose a grain pattern from the Film pop-up.

4. Adjust the slider up or down until the desired amount of Film Grain is added.

You can preview just the effect of the Film Grain by toggling the on/off control in the pane’s title bar.

NOTE: As is the case with the Sharpening pane, if you need to do further 
retouching or compositing work in Photoshop (or other editing app) after 
resizing your image, you should not use the Film Grain pane.
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TILING PANE

The tiling feature in Resize AI divides an enlargement into smaller pieces so that the image can be printed 
on a smaller printer. For example, you might want to create a mural that is 8 feet tall by 12 feet wide, but 
your printer can only print 24-inch wide strips. With the tiling feature you could automatically create six 
separate files that are 24 inches wide and 8 feet (96 inches) tall, to create your mural in sections.

With the tiling feature all you do is specify the size of paper you will print on, and if you would like the 
pages to overlap. Then Resize AI will resize your image and section it into the individual tiles. When you 
save or export the resized and tiled image, Resize AI will save the individual sections as separate files.

To use the Tiling pane:

1. Turn Tiling on by toggling the button in the pane header.

2. Set the Width and Height fields to the size and 
orientation of paper that you wish to print on, or you 
can select the number of rows and columns instead.

3. Set the Overlap size. The overlap makes each tile 
overlap so you can tape multiple panels together and corrects for printer margins if you are 
not printing borderless.

The preview will show cyan guide lines for each tile that will be created. The bottom of the Tiling pane will 
tell you how many tiles will be created.
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GALLERY WRAP

The Gallery Wrap feature is designed to help you print on canvas. When making enlargements for canvas it 
is common to wrap a portion of the image around wooden stretcher bars. These can be several inches thick 
and help mount the canvas. These are commonly called gallery wraps. However, if you had important detail 
near the edges of the image, it might be lost in the wrapping process. Resize AI’s Gallery Wrap feature 
automatically creates extended margins by reflecting or stretching the areas near the edge of the image 
without having to sacrifice any of the original image. You can select the thickness of the mounting bars and 
use different options for creating additional margins.

To use the Gallery Wrap feature:

1. Turn on Gallery Wrap in the pane’s title bar.

2. Set the Thickness control to the amount of margins you 
would like to add. A good rule of thumb is to use the 
thickness of the stretcher bars, plus half an inch.

3. Select the Type you would like to use (see the list below 
for details on the different options).

4. If you wish to add a color overlay to the gallery wrap 
wings set the color and opacity.

The Gallery Wrap feature has several settings for adding margins and adjusting the look of the wrap:

• Reflect: Copies an area equal to the thickness setting around your image, then flips each side 
and adds it as the margins. This is a good general-purpose technique.
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• Reflect Soft: Does the same as the Reflect method but softens the added margins.

• Stretch: Takes a small area around the edge of the image and stretches it to add the margins.

• Stretch Soft: Does the same as stretch, but softens the added margins.

The Thickness slider controls how thick your canvas stretcher bars are. Two inches generally works well for 
most gallery wraps.

You can darken the wrap or add a solid color to the wrap area with the Overlay Color and Opacity sliders. 
(The Opacity’s default is 0, which means that there is no color overlay added.)

PRESETS

Resize AI’s preset system is designed to help you get very specific 
crops for a wide range of paper and printer types. These include 
settings for photo lab print sizes, and for Epson, Canon and HP 
desktop-size and large-format printers, with matte, resin coated 
(photo), and canvas paper types.

In addition to being able to set document size and settings, and 
settings in any of the other panes, Resize presets always contain 
a Crop adjustment. What that means is that any time you apply a 
preset, Resize selects the Crop tool and places the crop overlay on 
top of your file. There, you can move the overlay to the appropriate 
crop area (or resize the crop) for your photo.

To apply a preset, choose the category you would like to use from 
the Presets panel. The category will expand to a list of the available 
presets for that group. Then, just click on the preset you want to 
apply.

Saving a Preset

You can create your own custom presets for specific print or output types. Once you have your settings 
that you wish to save, go to the Preset menu and select Save Preset, and choose a category you would like 
to save it in. If you have applied a preset to an image and make adjustments to any of the settings in the left 
panel, you can update that preset with the new setting by choosing Update Preset with Current Settings 
from the Preset menu.

To delete a preset, right-click on the preset in the Presets Browser and choose Delete Preset.

NOTE: You can also import and delete Resize presets from within the Extras 
Manager. See “Extras” on page 10 for more.
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Batch Processing in Resize AI (Standalone)
When you use Resize AI as a standalone app, you can open multiple images simultaneously, by either 
dragging a folder or selection of files into the startup window, or by clicking the Open Photos button and 
selecting a folder — or multiple items within a folder using your system’s file-selection tools. Once open, 
you can work on each image individually, or you can adjust the settings for one image and sync those 
settings to all (or some) of the images in the selection. When you’re finished with your session and click 
Done, Resize AI will export the collection via the Export window (see page 35 for more on Export).

When you open a group of images in Resize AI, a filmstrip appears at the bottom of the window, displaying 
each image with its original pixel dimensions and its resized dimensions (once you have applied Resize 
settings). All of the images will be selected, highlighted with your operating system’s highlight color, and the 
current image — the one visible in the Preview area — will have a bolder highlight around its thumbnail in 
the filmstrip. You can move between images by clicking on them in the filmstrip or by using the arrow keys.

With the open images, you can adjust the resize parameters for each image individually, by moving from 
image to image, or you can edit one image and click the Sync option at the bottom of the Resize window to 
copy that image’s resizing option to all of the other selected images in the group.

NOTE: When you use the Sync Settings option, all of the properties of the 
current image — including crop and crop position — will be applied to the 
selection. The crop is re-editable on any image during the session, however.
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Some additional notes about batch-processing images and working with the filmstrip:

• By default, all of the images in the group are selected, with the current image highlighted in 
bold. You can deselect an image in the group by Control-clicking (Windows) or Command-
clicking (Mac) on it in the filmstrip. This can be helpful if you wish to sync only some images in 
a group, or remove any images from the export group (see below).

• Clicking on a deselected image in the filmstrip will then select only that image.

• When you click Done, only the selected images will be exported. If you have made changes 
to the selection during your session, and want to export the entire group, use the Select All 
command to select all images in the filmstrip (Control-A for Windows, Command-A for Mac).

• The Reset All command only works with the currently selected image. If you need to reset all 
of your work, either choose Cancel (and reopen the batch) or click on each image and choose 
Reset All from the bottom of the window.

Soft Proofing in Resize AI
ON1 Resize AI’s soft proofing feature lets you see how a photo will look when printed, using the color 
profiles that get installed with your printer. Soft proofing helps you determine where there might be issues 
when you print, so that you can adjust your tone, color and effects to give you a print that is closer to your 
editing vision.

Normally, when you’re viewing an image in Resize, you are viewing it through the lens of your monitor’s 
display profile. The color gamut of your computer’s display is wider than that of most photo printers, which 
means that some colors you are able to view on-screen are not reproducible when you print. When this 
happens, the color profile conversion that happens in the print engine will cause substitutions of colors that 
the printer cannot print to the closest color that it can. This means that your image could have subtle (or 
broad) shifts in color, especially in certain color ranges.

Soft proofing is turned on via the View menu, or by clicking on the soft proofing icon to the left of the 
Preview button at the bottom center of the main Resize window. The background of the main preview 
window will change to approximate the color of the paper you’re profiling. 

Additional soft proofing options are available underneath the Enable Soft Proofing command in the View 
menu. The options are as follows:

After you have resized your photos, either individually, or via the Sync command, the new pixel dimensions for each image will be 
displayed at the bottom of each thumbnail in the filmstrip.
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• Gamut warning: When checked, this displays a red overlay for colors in the image that are 
out of gamut for the current print profile.

• Profiles: The Profiles submenu lists 
the currently available printer profiles. 
Choosing one will change the on-
screen display to use that profile.

• Intent: Resize offers two different 
rendering intents when soft proofing, 
used to convert the color from display 
to print. Perceptual shrinks the color 
gamut, which works to preserve the 
relationship between colors in the 
image. Relative only converts colors 
that are outside the current color 
gamut; this can sometimes cause two 
colors, one in gamut, and one outside, 
to be identical after conversion.  
 Neither rendering intent is perfect 
or desired; it often is a matter of the 
makeup of the image, your editing 
intent, the paper being printed on, and 
so forth. Often, you’ll want to switch 
back and forth between Relative and 
Perceptual, seeing which gives you a 
better print.

• Simulate Paper and Ink: Turning this 
setting on will cause Resize to use the 
white point for the chosen paper type 
(instead of the white point of your 
monitor), and the paper’s actual black 
density (instead of the display’s black 
point). If you’re trying to match a print, 
you will usually want this setting turned 
on.

Adjusting images with soft proofing is often a 
bit of trial and error. It’s easy to get caught up 
in eliminating out-of-gamut colors, but most 
modern photo printers—both home printers and 
online print services—do a pretty good job of 
approximating colors properly. 

The biggest thing you want to be looking for when viewing a soft proof is tone, contrast and color accuracy 
between screen and print. 

These three screen shots show the results of soft proofing options, as viewed 
in Resize. The top image is with soft proofing off (and is using the display 
color profile). The middle image is with soft proofing turned on, and using a 
printer profile for Epson’s Exhibition Fiber Paper. The bottom image has the 
Gamut warning turned on; out of gamut colors are highlighted by the bright 
red overlay.
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Understanding Resize AI: How Big Can I Print?
People often ask how big you can print with ON1 Resize AI. The simple answer is this: if your original photo 
is sharp, with good details and little noise, you can print almost as big as you desire. The limitations are the 
size of your printer or the capacity of your computer to work with large file sizes. In practice, however, even 
the largest prints are rarely more than 400 percent larger than the original photo. 

Historically, the standard viewing distance for photographic prints is generally considered to be twice the 
diagonal measurement of a print. For example, the ideal viewing distance for an 8x10-inch print would be 
slightly more than two feet away, while the viewing distance for an 80x100-inch print would be over 21 
feet. That last distance might seem like a lot, but that’s the kind of mural — almost 9 feet tall — you would 
see at an airport or shopping mall. (Keep in mind too that many photographers scrutinize their images closer 
than standard viewing distances; most people don’t get that close.)

Photos are perceived in color, tonality, textures, and sharpness. Other interpolation techniques maintain 
color and tonality but sacrifice textures sharpness by “inflating” the image uniformly. The image still looks 
similar, but will not be crisp. Depending on the amount of interpolation, this can be severe and noticeable 
even at standard viewing distances. ON1 Resize AI maintains the color, tonality, textures, and sharpness of 
a photo at all sizes. It can actually create new detail at the proper scale.

How Much Resolution Do I Need?
To answer this, you need to know two things:

1. The size of the print you wish to make.

2. The resolution that your printer needs for best results.

The size of the print can be as large as you would like, although, obviously, you will be limited by the 
maximum print size of your printer (although tiling can help). 

Resolution is the density of the pixels for a given measurement, usually in pixels or dots per inch (or 
cm). Most modern inkjet printers print anywhere from 1200 to 4800 dots per inch, but what the printer 
manufacturers really mean is 1200-4800 droplets of ink per inch. A common mistake is to set the 
resolution of the file to the resolution of the printer. In all but a few specialty printer types (like dye-
sublimation) this will lead to huge files that will not print well, if at all.

The secret is that the human eye cannot see more than 250-300 pixels per inch, and the ideal resolution for 
your files should be close to this. Once you know the print size and resolution, it is easy to use Resize AI to 
scale your file to the desired output size. Simply enter the resolution and the output specifics in the ‘Resize 
to’ section of the Photo Size pane. You’ll see that the corresponding dimension is automatically computed 
by Resize AI based on the proportions of your image.

Keep the proportions in mind because the proportions of film, digital camera sensors, and paper can all be 
different. For example, most digital camera sensors are proportioned so that the height is two-thirds the 
width or 1:1.5; While the most common paper size, in the US, is the letter which is 8.5×11 inches or about 
1:1.25. These kinds of proportion mis-matches are common and require that the original image be cropped 
to fit the proportions of the paper size. If your image cannot be cropped without ruining the composition, 
then you will need to adjust your print size to a longer dimension.
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Resizing an image larger than the original size requires new pixels to be created. This process is called 
interpolation or resampling. There are many mathematical ways, called algorithms, to do this. The most 
common method used by many pixel-editing apps is called bicubic interpolation. Bicubic along with its 
newer variants bicubic smoother and bicubic sharper work by averaging a small group of neighboring 
pixels to determine the color value of the new pixels to be added. While this technique is fast, it does not 
distinguish edges so there is a uniform loss of sharpness and detail across the image.

Resize AI uses a neural network trained on millions of examples of photos. It is fundamentally different 
from bicubic or other interpolation methods. It can analyze the photo and faithfully recreate textures in 
nature, at the proper scale, all while maintaining the sharp details and reducing noise and artifacts. All this 
number crunching may take a bit longer than the single pass interpolation methods like bicubic, but good 
things come to those who wait and the reward is far superior results.



PART 3: 
EXPORT, PRINTING AND SHARING



ON1 Resize AI 2023 User Guide Part 3: Export, Printing and Sharing 35

Export
Resize AI 2023’s Export window lets you export your photos with incredible flexibility, ease and 
control. When using Resize AI with a single image, you can access the Export window at any 
time from the File menu or the icon at the bottom right side of the window; when used in batch 
mode, the Export window is launched when you click the Done button at the end of a session.

The Export window is separated into two panels: Export Presets and Export Options. The Options panel 
contains specific types of options—file renaming, destination folders, file type and more—that you can use 
when you are exporting images from Resize. If you find that you are using a specific set of options all the 
time for your workflow, you can create a preset and apply that whenever you use Export.

The contents of the Export window include:

A. Export Presets: The current preset (if used), will be represented with a selection box around 
it, and the filled circle to the left of the preset name means that it will be used when the 
Export button is pressed. To use the Export Options panel without any preset applied, turn 
off all of the presets in the list, and click in the current preset once.
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B. Save Preset: Lets you save the current set of export options as a preset.

C. Naming: Renames the exported file based on criteria added to the rename box in the panel.

D. Destination: Lets you set the destination of the exported files. (required)

E. File Type: Sets the file type for each exported file. (required)

F. Resize: Not applicable in Resize AI, since the resizing operation is provided in the app itself. 

G. Sharpening: Applies sharpening to the exported images.

H. Metadata: Adds/removes metadata from the export. 

I. Watermark: Lets you add a text or graphic watermark to an exported image. 

J. Export/Cancel: Starts the exporting, or cancels it and returns you to Resize.

 Export Options

NAMING

The Naming pane gives you extensive controls for creating customized filenames using tokens in the entry 
box inside the pane, as well as with any custom text entered directly into the entry box. You can use any 
combination of tokens and text in the entry box, and the Example label directly above the box will display 
what your new filename will look like, using the 
first item in the export group.

To use this feature, click the control circle to the 
left of the label in the panel. Add any custom 
text, or click the Add Token pop-up menu to add 
tokens based on information associated with the 
image, including filename data, date and time 
information, and associated metadata There are 
four submenus in the Add Token menu:

• Filename, which includes options for using the original filename, number suffix (taken from 
the image as recorded by the camera) and enclosing folder name.

• Date/Time, which includes a list of date (year, month, day) and time data that can be 
combined in various ways.

• Sequence, which adds an incremented number to each renamed file in the batch, as well as 
the total number of files in the batch, with options for leading zeros in the resultant filename. 

• Metadata, which lets you add specific EXIF and IPTC metadata to the filename.

To build a rename sequence using tokens, click on the Add Token button, and choose the appropriate token 
from the pop-up menu. The token will be added as a shaded item in the text field, and the Example item 
above the text field will show a sample of a renamed file using the current set of tokens and custom text. 
To change an existing token, click on the down arrow on the right of the token, which will display the full 
set of tokens. To delete a token, double-click on it and press the Delete key.

Custom text can be added anywhere in the entry field. You can click the cursor at the beginning or end 
of a token (or in between tokens) and add spaces, dashes, underscores and any other text you wish to be 
included in each renamed file. Each change you make will be updated automatically in the Example label.
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The Presets pop-up menu at the top of the Rename window includes a set of common batch combinations 
that you can use as a starting point. You can also create your own batch-rename presets: build the rename 
options you wish, and choose Save New Preset from the bottom of the Presets menu. You can also update 
an existing preset and delete presets from this menu.

Because the Rename process is not undoable, make sure you use the Example field to check that your text 
and token combinations give you the filenames you expect for your batch process, and adjust as needed. 
When you’re sure, click Apply, and Resize will rename all of the files.

NOTE: A complete list of the tokens used in the Rename window, with 
explanations, can be found on page 41.

DESTINATION

The Destination pane is where you set the 
desired location for the exported images. At 
minimum, you must specify a destination folder 
for your export, but the pane has a number of 
options for adjusting the export location:

• The Folder pop-up menu lets you 
choose the same folder as the original 
images, another folder, or, can be set 
to ask for a destination every time, 
which can be helpful when you’re 
using an export preset.

• Checking the Put in Subfolder option 
will export the images to the folder—
or, create a new folder, if it doesn’t 
exist—specified by option’s text field.

• The Existing Photos pop-up is for 
those times when there might be a 
naming conflict within the destination 
folder. Replace will overwrite the file 
with the new one being exported, Skip 
will leave the destination file alone 
and not export the new file, and Keep 
Both adds a number ‘1’ to the end of the filename of the exported file, preserving both files.

• Generate Subfolders will subdivide the export based on the exported file’s metadata, 
creating subfolders as necessary—or, if the folders exist, placing the exported file into the 
appropriate subfolder. This option uses the same token-driven scheme (and presets) used in 
the Naming pane.

• After Export lets you determine what to do when Resize completes the exporting process. 
This includes displaying the image location in the Mac Finder or Windows Explorer, to create 
a ZIP archive of the exported group, to open in another editing application, or to run a script.



ON1 Resize AI 2023 User Guide Part 3: Export, Printing and Sharing 38

FILE TYPE

Like Destination, File Type is the other required 
element for using Export. Resize can export in 
DNG, PSD, TIFF, JPG and PNG formats. With 
the exception of DNG and PNG, each file format 
has specific options in the pane:

• Original includes options for embedding metadata and saving an ON1 sidecar file with the 
exported images.

• JPEG includes options for JPEG quality and for attaching a color profile.

• Photoshop includes options for attaching a color profile, bit depth, and whether to flatten 
any layers in the original image.

• TIFF includes options for image compression (none, LZW or ZIP), attaching a color profile, bit 
depth, and to preserve transparency.

• DNG and PNG have no additional options.

The File Type pane also includes an estimated file size for the first item in the group.

SHARPENING

The Sharpening pane has two modes, Sharpen 
For and Manual. The Sharpen For pop-up 
menu lets you choose from six options, based 
upon your final intent. There are four options 
designed for print output, Glossy Paper High 
and Low, and Matte High and Low, and two 
option for display output (for social media or 
online sharing), Screen High and Low.

The Manual setting provides a bit more control 
over the output sharpening, letting you adjust 
the Amount (overall strength), Radius (detail) and Threshold (masks out areas that shouldn’t be sharpened 
based on contrast). 
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METADATA

The Metadata pane lets you set which pieces of 
metadata are exported—or not exported—with 
the images in the export set. You can choose to 
export all Metadata or by clicking the control 
circle to the right of the All Metadata label. 
If you click that label off, you can then select 
which metadata items you wish to save by 
clicking the appropriate label.

When checked, the Remove Unmanaged XMP 
button only exports standard metadata; any proprietary image metadata created by other apps will not be 
included. 

WATERMARK

The Watermark pane adds either text- or graphics-
based watermarks to an image, with options for 
size and positioning, opacity, font type, and more. 
You can import your own logos and save either 
watermark type as a preset for frequent use. 

The Watermark pane also gives you a representation 
of your chosen watermark (on the first image in your 
export group), so you can adjust the parameters of 
the watermark precisely.

To create a new watermark, turn on the pane by 
clicking on the control circle to the right of the label. 
Choose either a preset from the Presets menu or 
click on the Add Watermark button in the lower 
right of the pane and choose either Text or Logo 
from the pop-up menu. Once you’ve selected a type, 
the bottom of the pane will open with settings for 
the chosen option. If you change your mind, click the 
Cancel button to the right of the Logo or Text labels.

Using graphics-based watermarks

The Logo section of the Watermark pane lets you 
use either watermark files imported via the Extras 
Manager (see page 10), which will be displayed 
in the File pop-up at the top of the Logo section, or 
by clicking on the Import button to the right of the 
menu (which will add them to the menu). 

Use the Position grid at the bottom of the pane to 
place your watermark, and use the Size and Inset sliders to move it within the area chosen. The Opacity 
slider adjusts the transparency of the watermark on the final image.
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The Repeat Image button will repeat the logo graphic rightward across the image from the location chosen 
in the Position grid. If you wish to repeat the watermark across the entire image, choose one of the sections 
on the left side of the Position grid.

When working with graphics-based watermarks, make sure your watermark file is sufficiently large for 
your usage. For example, if you want it to appear 2 inches wide on a 300-ppi image, your watermark needs 
to be at least 600 pixels wide. Or if you want it to appear across an entire photo—such as when posting 
to social media—it needs to be the same size as what you are exporting for the web, typically over 1000 
pixels. Using a watermark file that is too small will create a pixelated watermark appearance. And, because 
most watermarks are overlays on top of an image, these files are usually PNGs with areas of transparency, 
although JPGs can also be used, depending on the logo.

Using text-based watermarks

When creating text-based watermarks, the Text 
section of the pane has an entry box for your 
watermark text, a font selection area, and the same 
Appearance and Position options found in the Logo 
section.

The text entry box can contain multiple lines of 
custom text, and has the same token-based naming 
options found in the Naming pane (discussed on 
page 36), which can be helpful when exporting 
informational slides or for other data-driven uses.

You can set the font from the pop-up menu, and 
the font color by clicking the swatch on the left side 
underneath the font name. The text style can be 
set to bold, italic or underline, and the alignment to 
left, center or right. If you’d like to add a background 
color to the text box, turn on the Color Fill button 
on the right side of the pane.

Use the Position grid at the bottom of the pane 
to place your watermark, and use the Size and 
Inset sliders to move it within the area chosen. 
The Opacity slider adjusts the transparency of the 
watermark on the final image.

Saving watermark presets

Both watermark types can be saved as a preset 
for re-use later. To save a preset, adjust your Logo 
or Text settings as desired, and choose Save New 
Preset from the Presets menu. If you wish to adjust 
an existing preset at a later time—with a new logo 
file, for example—choose the appropriate preset 
from the Presets menu, make your changes, and 
choose Update Preset with Current Settings from the Presets menu. You can also rename and delete 
watermark presets from this menu.

With text-based watermarks, you can not only create simple, single-line 
watermarks showcasing your business, but you can also create 
data-driven watermarks (using tokens) for presentations and the like.
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Exporting and Export Presets
The Export window has been designed to offer as much or as 
little complexity as you would like. At its simplest, you can set the 
Destination and the File Type to your desired settings, leave all of 
the other panes alone, and click Export. 

Resize will remember your last Export setting—including anything 
you did in the Naming pane—the next time you export, so you 
don’t have to worry about which settings need to be set, and which 
ones don’t. You can use the Show/Hide buttons in the title bar 
of each pane of the Export Options panel to display only those 
settings you want to see.

Once you have your settings the way you’d like, you can save them 
as a preset by clicking the Save Preset option in the Preset panel 
on the left. Then, when you click that item in the Preset panel, the 
Export Options will be set to the specifications of that preset.

The Export Presets panel will display a list of the currently 
available presets. If you have selected a preset, it will have a 
selection box (in the app’s accent color) around it, and if the control 
circle is filled, the preset is on, meaning that clicking the Export 
button will export using that preset. If you don’t wish to use a 
preset, click the control circles off on all of the presets in the list.

By default, each preset will have up to three lines of explanatory 
text underneath the preset name, displaying the file type—DNG, PSD, TIFF—and the Destination 
information. This can be helpful when you’re scanning presets for a specific destination, but you can also 
collapse the preset to its title by clicking the Hide button in the title bar.

When you change the settings for a selected preset, Resize will ask you if you wish to update the preset 
with the new settings either when you click the Export button to start the process, or when you switch to 
another preset with the Export window.

It is possible to export more than one preset at a time. Every preset in the Presets panel that has the 
control circle set to On (filled) will be included in the export operation. This might be helpful to create 
backups on another disk, for example, or to build proxy versions for use while the original is being edited.

About Resize AI’s File-Naming Tokens
When using the Naming option in the Export window, ON1 Resize AI includes a broad set of tokens that 
you can use as part of the strings to build complex filenames, in conjunction with any custom text you wish 
to use as part of the filename. These tokens draw on image metadata, including filenames, dates taken, 
and the complete list of both EXIF and IPTC metadata fields. You can use these tokens in any number of 
combinations.

To build a rename sequence using tokens, click on the Add Token button, and choose the appropriate token 
from the pop-up menu. The token will be added as a shaded item in the text field, and the Example item 

All presets include an informational view that lists 
the export file type, the destination folder, and 
resize information. If you don’t wish to see that, 
click the Hide button to collapse the view to just 
the preset title.
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above the text field will show a sample of a renamed file using the current set of tokens and custom text. 
To change an existing token, click on the down arrow on the right of the token, which will display the full 
set of tokens. To delete a token, double-click on it and press the Delete key.

Custom text can be added anywhere in the entry field. You can click the cursor at the beginning or end 
of a token (or in-between tokens) and add spaces, dashes, underscores and any other text you wish to be 
included in each renamed file.

There are four categories of tokens, each with their own set of options: Filename, Date/Time, Sequence, 
and Metadata. A description of each is listed below.

FILENAME

The Filename tokens use information from the 
filename or the enclosing folder that the file resides 
in. There are three options, Filename, which adds the 
current filename of the file being worked on; Filename 
Number Suffix, which takes the index (shot) number 
from the original raw file, if available; and Folder Name, which grabs the name of the folder in which the 
renamed (or imported) file resides.

DATE/TIME

This submenu consists of 17 combinations of date and 
time data, as taken from the image’s metadata. There 
are prebuilt date and time combinations (20220104, for 
example, for a year-month-date token) in the list, or your 
can build your own combinations out of the subtokens 
listed in this menu. 

Year data can be presented in either 4- or 2-digit 
numbers, and Month data can be presented in month 
number, full name, or 3-letter abbreviations.

You can use a combination of tokens and custom text to rename files to exacting specifications, drawn 
from file information, metadata and more.
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SEQUENCE NUMBER

The Sequence Number tokens come into play when 
exporting, importing or renaming a group of image files. 
There are essentially two tokens here, Sequence and Total, 
with options for padding zeros into each item. Sequence will 
take the group of images being worked on and, starting with 
the first item in the selection, will start at 1 and increment 
by one as each image is processed. The Total token will 
always be a single number—the number of items in the group 
being processed.

The combination of Sequence and Total tokens lets you 
create strings like ‘filename_07 of 22’ as part of the new filename.

METADATA

This submenu has five items, each with its own submenu. 
All of the items create the chosen token based on the 
embedded metadata for each image being renamed, 
imported or exported. The specific text pulled from the 
Camera and IPTC tokens will be visible in the Metadata 
pane’s EXIF (for camera-specific data) and IPTC tabs.  

NOTE: Resize AI has no provision to add metadata to an image; the tokens 
referenced here use any embedded metadata found in the image. If there 
is no information in the specified Metadata token, it will be ignored during 
processing.

Camera

The Camera submenu includes 21 items, all of which are 
directly taken from an image’s EXIF data. Not all cameras 
capture all of the items listed, but most of them save essential 
items like exposure information, focal length and more.
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Ratings and Labels

The three tokens in the Ratings and Labels submenu pull 
information from any rating, label and like information associated 
with the image.

The Rating token will add the number of stars an image is rated, 
while the Label token will add any color label information (red, 
yellow, green, blue, purple), and the Likes token will add Liked, Not Set, or Disliked to the image name.

IPTC Metadata Tokens

IPTC (International Press Telecommunications Council) is an industry-standard metadata format, and offers 
much more detailed metadata information than EXIF. It historically has been used by journalists and stock 
photographers to catalog and tag photos, as well as add copyright information, captions, and other data. 
There are nearly 30 different tokens in the IPTC metadata submenus, which are divided into Contact, 
Content, and Image.  

Using IPTC information makes the most sense when you have a strict method for importing and 
categorizing image data during import (or shortly thereafter).
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Printing
ON1 Resize AI 2023 has a flexible print engine that can print photos at any size. You can print photos 
individually; multiple photos package style, on a single piece of paper; and contact sheets for evaluating 
images. You can print from any module, even when using Resize as a plug-in. 

The print window can be opened by clicking on the Print icon in the module selector, or by selecting the 
Print command from the File menu. It has the following components:

A. Preview: Displays the photo or photos being printed.

B. View Selector: Lets you view the photos being printed individually, in facing-page view, or in 
grid view. The icon on the far right turns soft proofing on and off.

C. Filmstrip: Shows all of the photos that have been selected for printing, with check marks to 
turn printing on or off. (The Filmstrip is not visible when a single image has been selected for 
printing.)

D. Page view: Displays the number of pages being printed, and lets you move from page to page.

E. Printer pane: Contains options for output—printer or PDF—as well as printer, page setup, 
page size, number of copies, resolution, and printer profile and rendering intent.

F. Print Area pane: Contains options for fitting and selecting the print image size.

G. Watermark pane: For adding a watermark to printed photos.

H. Sharpening: Options for sharpening during the print process.

I. Print/Cancel: Print One (current image), Print All, or Cancel.
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The four panes in the Print window—Printer, Print Area, Watermark, and Sharpening—each deal with a 
specific printing-related task.

PRINTER PANE

The Printer pane is where you set the printer-specific features 
for your output. It has two modes, which are chosen by clicking 
on the icon at the top of the pane: Print, which lets you print to a 
connected printer, and File, which will print the selection to a PDF. 

When choosing to output to a printer, you’ll set the specifics of 
your printer, the paper size you wish to print to, the resolution, 
orientation, and the number of copies. When choosing resolution, 
make sure that you are printing at the printer’s optimal resolution. 
Most photo printers, for example, work best with a file that has 
between 240 and 360 ppi. (Resize will use its internal resampling 
engine to ensure that your photo is at the print resolution you 
choose.)

At the bottom of the pane is a section for choosing a printer-specific color profile; choose the media profile 
for the paper type you are printing to. 

The rendering intent is related to the conversion of an image’s colors to fit within the color range (or gamut) 
of the printer. The default intent, Perceptual, will change all of the colors in a photo proportionally to fit 
within the printer’s range of colors. The other option, Relative Colorimetric will only change the colors 
out of the printer’s gamut, to the closest in-gamut color. Depending upon the image, you might need to 
play with the intent settings, but Perceptual is usually the best place to start. (You can use Resize AI’s Soft 
Proofing feature to look at out-of-gamut colors in your photos. See “Soft Proofing in Resize” on page 29 
for more.)

NOTE: Resize AI’s Print feature will work with borderless printing options as 
well. Be sure to choose your printer’s borderless options in the Page Setup 
window. Different printers will have specific borderless settings, so check the 
printer’s manual to see how to turn borderless printing on, and how to achieve 
the proper sizing.

Printing to a file

In addition to sending images to a printer, you can also choose to export the current print job to a file. This 
can be helpful if you are submitting prints to an online service or to print remotely.  To use this option, click 
on the File icon at the top of the pane. Resize will ask you for a filename and a location to save the file. 
Choose a page size for the file from the Page Size pop-up, and adjust your print area settings. When you 
choose Print, Resize will create a PDF of the photo (or photos) and save it with the name and destination 
you specified earlier.

The Printer pane sets printer-specific options for 
the current print job. You can also choose to render 
the print job to a PDF file.
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PRINT AREA PANE

The Print Area pane is where you set the options for the size of the 
print, and how you wish your photos to be printed. You can also 
choose whether to print photos individually, package-style, or to 
create a contact sheet for evaluative purposes. 

The top of the pane includes preset styles for either fitting the 
current photo inside the print size, or filling the entire print size;  
options for printing at common print sizes, including 8x10, 5x7, 
4x6; and options for printing to a contact sheet. You can also 
create custom print sizes via the Custom section at the bottom 
of the pane; just set the width and height of the print size, and 
whether you wish to fit the image to the print size, or to fill the 
frame with it. If you would like to save this print size as a style, 
click on the More pop-up at the top of the pane, and choose Save 
as New Style from the menu. You’ll then be able to recall that style from the More pop-up whenever you 
print.

If you are printing multiple photos, Resize will attempt to put as many photos at your chosen print size 
on the paper size as defined in the Printer pane. To print only one photo per page, click that option at the 
bottom of the Print Area pane.

Page size vs. print size

It’s worth understanding the distinction between the page size and the print size. In some cases, the two 
will be identical. For example, if you wish to print on 4x6-inch photo paper, you would choose that option 
in the Printer pane’s Page Size pop-up, and then 4x6 in the Print Area’s Custom pop-up. Depending upon 
the aspect ratio of your photo, you then might need to choose Fit or Fill to get the proper crop. Fit does 
exactly what it sounds like: it will fit the entire photo within the bounds of the photo’s dimensions, which 
means that there could be some extra white space around the final print. Fill will resize the photo to fill the 
dimensions of the chosen print size, centering the image. 

In our example, a 4x6-inch print has an aspect ratio of 2:3. If the photo you are printing has that aspect 
ratio, then Fit and Fill do the exact same thing: the photo will fill the print area without any cropping.

For package printing, where you wish to generate multiple prints on a larger sheet of paper, you’ll set the 
specific size paper you are printing to in the Printer pane, and then set the appropriate print size for each 
photo in the Print Area pane.

The Print Area pane is for setting the actual print 
size of the photo or photos you are printing.
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WATERMARK PANE

The Watermark pane adds a graphic overlay to the printed image, 
and is most often used for your logo, signature or copyright. 
Watermarks generally need a transparent background, so make 
sure your watermark file is a PNG or PSD.

The module has the following options:

• Choose: Click the Choose button to select the file you 
wish to use as your watermark. Once you’ve added a 
watermark file, it will be saved to the Logo File pop-up.

• Size: This slider controls the size of the watermark file.

• Inset: This will determine the percentage in which the 
file is inset from the edge, based on the Position (see 
below).

• Opacity: This sets the opacity of the watermark.

• Position: This grid sets the location of the watermark. 
Click on the square of the location you desire.

When working with watermarks, make sure your watermark file 
is sufficiently large for your usage. For example, if you want it to 
appear 2 inches wide on a 300-ppi image, your watermark needs to be at least 600 pixels wide. Otherwise, 
it could appear pixelated on the print.

NOTE: Graphic watermarks imported via the Extras Manager (see page 10) 
will appear in the Logo File pop-up menu. In addition, any watermarks imported 
via the Choose button in the Watermark pane will be accessible in the Extras 
Manager and in the Export window’s Watermark pane.

SHARPENING PANE

In most cases, and depending upon the media type you print 
to—glossy papers often benefit from additional sharpening, for 
example—you’ll need to add an additional sharpening step when 
printing. This is an additional level of sharpening beyond anything 
you might have applied in Resize.

The Sharpening pane lets you select a type of sharpening that will 
be applied to your photos during the printing process. The pop-up 
menu has a set of options for general sharpening, including ones 
for a standard print, glossy papers, details, high-pass sharpening, 
and many more. Depending upon the image, you might need 
to play with the settings here; performing test prints on small 
sections of a photo can often be quite helpful in determining the proper level of sharpening in a print.

Use the Sharpening pane to add additional 
sharpening to your printed image.
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BASIC PRINTING WITH RESIZE

Printing is available while you have an image open in ON1 Resize AI 2023 (or images, when using the 
standalone version of Resize AI in batch mode). Clicking the Print icon will open the Print window with 
the current image. There, you can set any of the options in the four panes on the right, and click the Print 
button to output your photo. 

If you wish to get an on-screen proof of the final image before you print, using the chosen color profile for 
the media type you are using, click the soft proofing icon underneath the preview area.

PRINTING MULTIPLE PHOTOS

When working with Resize AI’s standalone batch mode (see page 29), you can print from the group of 
photos—as a package or contact sheet —by clicking the Print icon. The selected photos will be displayed in 
the filmstrip at the bottom of the Print window, and the preview area will display the current page (at the 
printer’s page size) and print size settings. If you are printing a lot of photos at one time, you can flip from 
page to page via the Page View buttons under the preview. To see more pages, click on the Facing Pages or 
Show All Pages icons at the bottom left of the window.

The Print feature gives you extensive options for printing multiple pages package style. Here, we have selected 24 photos to 
print at 5x7 inches on a letter-size sheet, on an Epson P600 printer. Clicking on the View All Pages button underneath the 
preview window, you can see all of the photos to be printed. Clicking Print One will print the currently selected page; clicking 
Print All will print the collection. 
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If you decide that you don’t want to print a photo, unclick the checkmark for that photo in the filmstrip. To 
print all of the photos currently selected, click Print. If you would like to try a test print, with a single page, 
click on the Print One button, which will print the currently selected page, as found in the Page View listing.

PRINTING CONTACT SHEETS

When you wish to evaluate a group of images but don’t want to waste larger sheets of photo paper, use the 
Contact Sheet feature in the Print window. Select the photos you wish to print, set the paper size in the 
Printer pane, and click on the Contact icon in the Print Area pane.

When you switch from Package to Contact mode, you have two options, as found in the Custom section of 
the Print Area pane:

• Columns: lets you set the number of columns across the page width. The smaller the number 
of columns, the larger the individual cells.

• Captions: Currently, Resize lets you add the filename as a caption underneath the printed 
photo. Click the button to the left of the label to turn this on or off. (We will be adding 
additional caption options in future releases.)

You can use the Page View controls underneath the preview area to move between pages, and, when 
you’re ready to print, click the Print All button to print the contact sheets.

The Contact Sheet option lets you evaluate a large group of photos in a high quality print, with captions.
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Sharing Options (MacOS Only)
The MacOS version of ON1 Resize AI 2023 includes a number of photo-sharing options, including:

• Mail: Creates a new email message in Apple Mail with the shared 
photo.

• AirDrop: Uses Apple’s AirDrop networking feature to share with 
local MacOS or iOS devices. 

• Notes: Adds the shared photo to Apple’s Notes app. You can 
choose to create a new note, or add the photo to an existing note.

• Messages: Shares photo to Apple’s Messages app.

• Add to Photos: Adds the photo to Apple’s Photos app.

All of the sharing options perform the same operation: Resize exports a full-size JPEG of the selected photo 
and shares it with the selected target from the list. 
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RESIZE MENUS
ON1 Resize AI 2023 (MacOS Only)

• About ON1 Resize AI 2023: Opens the about box, displays 
your version number. (This is in the Help menu on Windows)

• Preferences (Mac): Opens the preferences dialog. (This item is 
in the Edit menu on Windows.)

• Quit ON1 Resize AI 2023: Quits ON1 Resize.

File Menu
• Done: Saves the current image and returns to the startup 

window or external source.

• Cancel: Cancels any Resize operations and returns to the 
startup window or external source.

• Quick Export: Saves the current image in Photoshop, TIFF, 
JPEG or PNG format

• Export: Opens the Export window.

• Export with Preset: Exports the current selection using a 
preset from the hierarchical menu, bypassing the Export 
window.

• Export with Previous: Exports the current image with the last-
used Export setting.

• Print: Opens up the print dialog box.

• Manage Extras: Opens the Extras Manager window.

Edit Menu
• Undo: Removes the last file operation.

• Redo: Redoes the undo operation.

• Cut: Cuts the currently selected item.

• Copy: Copies the currently selected item.

• Paste: Pastes the items in the clipboard.

• Keyboard Shortcuts: Lets you add or modify the hotkeys for 
many of Resize’s commands.

• Preferences (Windows): Opens the Preferences dialog.
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Settings Menu
• Reset all Settings: Resets any settings made in Resize (current 

image only).

• Copy Settings: Copies all of the Resize AI settings applied to a 
photo. (Copy is kept as long as Resize remains open.)

• Paste Settings: Pastes the copied settings to the current 
photo. (Kept as long as Resize remains open.)

• Paste Settings from Previous Edit: Applies any Resize AI 
adjustments made to the previous photo to the currently 
selected photo. (Only applicable when using Resize AI in batch-
processing mode.)

• Sync All Settings: Applies all of the Resize settings from 
the primarily selected image to the rest of the images in 
a selection. (Only applicable when using Resize AI in batch-
processing mode.)

• Save Settings as Preset: Saves a new preset.

• Update Preset with Current Settings: If an image with a 
preset applied has had some settings changed, this lets you 
update the preset to reflect those new settings.

• Rename Preset: Renames the current preset.

• Delete Preset: Deletes the currently selected preset.

• Export Preset: Exports the current preset as an .onresize file.

• Import Preset: Imports ON1 Resize preset files.

View Menu
• Zoom In: Zooms the preview window in one increment. This 

will make the preview image larger.

• Zoom Out: Zooms the preview window out one increment. 
This will make the preview images smaller.

• Fit to Screen: This sets the preview image so that the entire 
image is on screen at once. Think of this as an overview of the 
entire image. This is the setting you will use most of the time.

• Actual Pixels: This sets the preview image so that it zooms to 
actual pixels or 1:1 also called 100%. This setting allows you 
to see every pixel in the image. This is useful when making 
precision adjustments.

• Show Clipping: Shows the clipping overlay view, displaying the 
pure white or black pixels in the current image.

• Show Preview: Toggle to enable or disable the preview.

• Compare: Displays an adjustable split-screen view, with the 
Before view on the left side of the preview area.

• Preview Background Color: Lets you set the background color 
options for the Preview window.

• Enable Soft Proofing: Turns on soft proofing.

• Gamut warning: Displays colors that the printer can’t 
reproduce with a red overlay.
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• Profiles: Displays a list of installed printer and display profiles; 
selecting a profile will apply soft proofing for that profile.

• Intent: Lets you switch between perceptual or relative 
rendering intent for the current image.

• Simulate Paper and Ink: Sets the white point and black point 
of the display to account for that of the chosen profile.

Window
• Minimize: Minimizes your screen.

• Zoom: Zooms your window to full-size (doesn’t hide menus).

• Full Screen: Toggles full-screen mode (hides menu bar).

• Navigator/Loupe/Histogram: Hides or shows the Navigator, 
Loupe, Histogram (Levels) and Info pane.

• Document Size: Opens or closes the Photo Size pane.

• Settings: Opens/closes the settings pane.

• Sharpening: Opens or closes the Sharpening pane.

• Film Grain: Opens or closes the Film Grain pane.

• Tiling: Opens or closes the Tiling pane.

• Gallery Wrap: Opens or closes the Gallery Wrap pane.

• Solo Mode: Keeps only one control pane open at a time.

• Show Browser Panel: Hides/shows the left Browser panel.

• Show Control Panel: Hides/shows the right Control panel.

• Hide Panels: Hides or shows all Panels.

• Document Name: Shows the name of the current image.

Help
• Search: Searches the menu options (MacOS only).

• Learning Hub: Opens the Learning Hub window inside Resize.

• ON1 Resize AI 2023 Online Help: Opens ON1.com support 
page in your default web browser.

• Video Tutorials: Opens ON1.com product training page in 
your default web browser.

• Check for Updates: Checks with the ON1 update server to 
see if you are running the current version. 

• Sign-In/Sign-Out: Uses your ON1 account login information 
to authenticate your copy of ON1 Resize AI 2023.

• Provide Feedback: Opens the default web browser and goes 
to the feedback page of the ON1 website.

• About ON1 Resize: Opens the About box.

• Help Improve ON1 Products: Opens the Improve ON1 
Products dialog.

• Show ON1 Log: Diagnostic tool that can help ON1 support 
when you’re having issues with ON1 Resize AI 2023.
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PREFERENCES
ON1 Resize AI 2023 has a number of system-wide settings that you can set via the Preferences window. To 
access Preferences, either click on the gear icon at the lower left side of the screen, or choose Preferences 
from the ON1 Resize AI 2023 menu (MacOS) or the Edit menu in Windows.

The Preferences window has four tabs: General, Files, Plug-Ins, and System. The settings in each tab are 
described below.

GENERAL SETTINGS

The General settings tab adjusts basic settings 
for the Resize workspace, including background 
color, scrolling controls and more.

Scrolling Controls

Lets you select how the mouse scroll wheel or 
scrolling gesture works. The options are:

• None: Default.

• Preview Zoom: Adjusts the zoom of the 
preview window. Scrolling up increases 
the zoom, scrolling down decreases the zoom.

• Preview Pan: Pans the image, like using the pan tool or navigator. It is important that the panning is 
comfortable, not too fast or slow or jerky.

• Brush Size: Not applicable in Resize AI.

Font Size

Sets the size of the text in the basic Resize AI workspace (labels, panes and pop-up menus) to one of three 
general sizes: Small, Medium, Large. 

NOTE: When changing the font size, you must quit and restart Resize AI for 
the the new setting to take effect.

Preview Background Color

You may select the color of the background behind the preview image. The default color is black. There is 
options for black, white, light gray, dark gray and custom. The custom option has a color picker where you 
can select your own background color.
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Accent Color

Lets you choose the display color for highlighted items (folders, tabs, selections) in the Resize interface.

Application Language

Lets you change the display language for ON1 Resize AI 2023. Auto will use your system’s default language 
(if available).

Check for Update on Launch

Enabled by default, the product will communicate with ON1’s software update server when you start 
Resize AI; if an update is available it will prompt you to download or skip.

FILES

The Files tab has two options: 

Apply Lens Correction to Raw Files

With this option on, the lens correction profile 
will be applied automatically on any raw photo 
when you preview it in Resize AI.

Disable Base Corrections on Raw Files

With this option on, Resize AI will turn off the basic file correction settings applied to all raw images. This 
can be helpful for scientific/technical photography, time-lapse, and other specialized applications.

PLUG-INS

The Plug-Ins tab is specific to using Resize as a 
plug-in Lightroom, and sets up conditions when 
opening files from these apps. 

General

When checked, the “Leave ON1 Resize AI 2023 
Open” option will keep the app open after 
processing an image via an external editor.

Lightroom

This lets you choose the specific options for 
files opened via the Plug-In Extras menu in 
Lightroom:

• File Type: The file type drop-down menu determines what type of file will be created. The default is 
PSD, which maintains layers. You can also select JPG or TIFF if you prefer those formats and are not 
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concerned about maintaining layers. The last option is same as source, which maintains the file type of 
the original file, except for Lightroom raw files, which are saved as PSDs.

• Color Space: Sets the working color space; Adobe RGB, sRGB or ProPhoto RGB.

• Bit Depth: Sets the file bit depth, either 8-bit or 16-bit per pixel.

• Resolution: The resolution drop-down menu determines the resolution of the file.

• Stack with Original: When enabled, the new image is stacked with the original image.

• Use Original for Single PSDs: When enabled, if you select a single PSD file, it will be edited directly, 
rather than having a copy made.

• Ask Every Time: When checked, Lightroom will present these export copy options whenever you chose 
an item from the Plug-In Extras submenu. Turning this option off will bypass the file-export window 
inside Lightroom, using the options set here.

SYSTEM

The System tab displays performance-related 
characteristics of Resize AI 2023.

AI processor

Sets the processing option for Resize’s AI-based 
operations. By default, the option is set to Auto, 
which uses the best combination of system 
resources to process tasks. If you are noticing 
some performance issues with Resize, you can 
try setting the options to either your CPU or your 
graphics card.

Memory Usage
• System Usage: Specifies the amount of 

RAM that is used by the application. The 
maximum (default value) is 80%.

• VRAM Usage: Specifies the amount of video memory (VRAM) that is used by the application. The 
maximum (default) is 80%.

Scratch Folder Location

This setting lets you move or reset your memory cache, which helps speed editing operations while you’re 
running Resize. This is helpful if your system drive has limited space and wish to use a faster external drive 
as a cache. This cache information is purged each time you quit the application.
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Performance

The Performance section is designed to help you optimize Resize for your specific setup. The adjustments 
you can make are as follows:

• Video Card Strength helps improve the performance of image previews in Resize. If you have a high-
end video card try turning it up for faster preview updating.

• Fast Panning reduces the preview quality (makes it less sharp) while panning the photo to improve 
performance of panning.

• Fast Preview reduces the preview quality (makes it less sharp) while painting or making other 
adjustments to improve paintbrush performance. This is off if you have a high-end video card.

• GPU Render uses the GPU (video card) to render preset thumbnails, exporting, printing, sharing and 
caching. This can greatly improve performance. It is on by default for systems that support it. It may be 
disabled on lower-end GPUs.
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